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MAGICDRAW BASICS

STEP #1 Create a class diagram

1. Create a new project in MagicDraw. From the File menu, choose New Project and then select
the Blank Project icon. Name the project or leave it untitied by default and click OK.
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2. In the diagrams toolbar, click on the Class Diagram button . The Create Diagram dialog

box appears.

Etreate Diagram

General |

Type Class Diagram name:

rtited1]

Select owner for diagram:

G

Kl |

Create Ciwner | Clame

E ML Standard Profile < <auxiliaryResc

2
|

(o] 4 | Cancel | Help |

3. In the Type Class Diagram Name field, enter the name of the new class diagram or leave the

default name.

4. From the package tree, select the package where to contain the diagram (default is Data) or
create the new one by clicking the Create Owner button and choosing Package from the list.
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5. Click OK. The diagram is created and the diagram pane appears.
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STEP #2 Create a new class element in diagram

1. In the diagram toolbar, click the Class button = . Click again on the diagram pane in order to
place the class. Type the name for a class. Click anywhere on the diagram pane to close the

class title line.
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2. The class that you see on the diagram pane is only the class symbol. All the class data are con-
tained in the Browser. You can see that the class Customer has been created in the browser
when you have drawn it on the diagram pane.
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3. Double click on a class. The Class Specification dialog box appears. It contains various fea-
tures of a class. For more detailed information about this dialog box, see MagicDraw Help.
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4. Select the Documentation/Hyperlinks group, add some documentation about this class. Click

Close.
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STEP #3 Create package element in diagram

1. On the diagram tool bar, click the Package button

h .

1. Place the package on the diagram pane and name it System. Drag any corner of a package in
order to reach its desired size.

2. Move a class into the package. A blue border around the package appears when the class is
dragged into it and it shows that the class is included into package.

. Customer
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3. Right-click on a class to access its shortcut menu. Choose the Select in Containment Tree

command.

System
Customer
Specification Enter
Symbolis) Properties. .. Alt+Enter
Mew Diagram ]
Go To b

Related Elerments b
Conwverk To ]
Tools b
Skereotype ]
Create Roles b
Presentation Cplions ]
Insert Mew Atkribute Chrl+-Alk+A
Insert Mew Operation ChrlAlE+ 0
-

4. The class name becomes marked by dark blue fill in the Browser tree.

System
N chomer
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STEP #4 Create new class element from browser

1. Right-click the System package symbol in the Browser tree. From the shortcut menu, choose
the New Element option and then Class.
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2. A new class in the package will appear in the Browser tree. Name the class Ticket.
3. Select the class in Browser and drag it onto the Diagram pane into the package.

STEP #5 Draw relationships

1. In the diagram toolbar, click on the Association button s . Connect the two classes with this

path. If it is allowed to draw the link from one element to another, a blue border appears around
it.

NOTE You can draw some paths by clicking handler buttons on the class
symbol.

2. To change the style of the path, click on special buttons

I 7 2 inthe toolbar,

3. Double click on the path. The Association Specification dialog box appears.

NOTE: For more detailed information about this dialog box, see MagicDraw
Help
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4. In the Name field, enter the path name owns. Click Close.

5. Drag the association name link around and leave it on the diagram pane. Select the link. From

the main toolbar, using a special Reset Labels Positions button ;<2 , put the path’s name

into place.

NOTE: The same action can be performed using handler on the link.

System
Customer Tir~
b
WS |

12
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STEP #6 Presentation options

1. Click on a class to select it. On the toolbar, go to the symbol editing buttons

AT

and click the Fill Color. Choose a color and click on it. The class fill color has been changed.

Note: If not all symbol editing buttons are displayed on the diagram toolbar,
from the toolbar shortcut menu, select the Expert Mode check box.

2. Click on Text Color. Choose a color and click on it. The class text color has been changed.

3. Click on an association to select it. Go to symbol editing toolbar and click Line Color. Choose a
color and click on it. The association line color has been changed.

STEP #7 Browser options

1. In the left down Browser, click on the Documentation tab B Documentation l . The Docu-

mentation window will appear. Select a class containing the documentation. The documenta-
tion of a class will appear in the Documentation window.
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3. Zoom in/out the picture by dragging the slider of the sliding scale to over/under 100% or zoom
in/out the picture by dragging the blue border around the diagram in Zoom window.

NOTE: To add slider to the Zoom tab, from the Options main menu, choose
Environment and in the opened dialog box, Browser group, select the
Show diagram zoom slider check box.



SEQUENCE DIAGRAM
CREATION

This guide contains step-by-step instructions, showing how to create a sequence diagram.

For creating a sequence diagram, an example of the Magic Test system will be given.

STEP #1 Create a Robustness diagram

1. Create a new project.

2. In the Browser tree, from the Data package shortcut m enu, choose New Diagram > Custom
Diagrams > Robustness Diagram. Name the Robustness diagram as Magic Test.

3. In the diagram draw elements, displayed in the Figure 1 on page 15.

package Data [ [Fig| MagicTest ]J

> .9 _-6__ _6__o

Instructor LoginDialog SystemAccessManager ProfileManager InstructorProfile

Figure 1 -- The Design robustness diagram

STEP #2 Create sequence diagram

1. In the Browser tree, from the Data package shortcut menu, choose New Diagram > Sequence
Diagram.

2. Name diagram as Change Password.

STEP #3 Create lifelines

i. Try below listed lifelines creation ways:

e Drag and drop the Instructor actor from the Browser to the diagram pane (Note: you can also
perform this action for multiple selection).

e Draw lifeline from the diagram toolbar:
1.) In the sequence diagram toolbar, click the Lifeline button 57 .
2.) Click on the diagram pane in order to draw a shape.

3.) From the lifeline shortcut menu select Type drop down list and select lifeline type
Instructor.
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interaction Change Passwaord] @ Change Password ]J

Figure 2 -- The Change Password sequence diagram, lifeline with Instructor type

ii. In the same way in the sequence diagram create lifelines for the LoginDialog, SystemAccessManager, Pro-
fileManager, InstructorProfile elements.

interaction Change Password| M Change Password L

Instructor 5 J
—_—

exhoundary>> o | =acorirol>» - [——— - <=l ity>» -]
: LaginDialog : SystemAccessManager : ProfileManager ;

Figure 3 -- The Change Password sequence diagram

iii. You can display Image instead of lifeline shape. To change the lifeline representation on the diagram pane:

1. On the diagram pane from the lifeline shortcut menu select Symbol(s) Properties. The Prop-
erties dialog opens.

2. Change the Show Stereotypes property to Shape Image.
3. Change the same property for the rest of lifelines.

interaction Change Password | #i§ Change Password ]J

= o o, .

: Instructon - Lnnin[haluq 1 SystemAccessManager : ProfileManager : InstructorProfile

Figure 4 -- The Change Password sequence diagram - images displayed instead of Lifeline shapes



STEP #4 Link messages and alternative fragment

i. Create Instructor message to LoginDialog:

1. Click the Message button —+ Message and draw message from Instructor to LoginDialog.
2. Type in message name as Type in new password twice.

ii. Create LoginDialog message to itself:

1. Click the Message to self button = Message to self and click on LoginDialog lifeline.

2. Click on created message name and click the green balloon on the right - the Operation dialog
will appear.

3. Type in operation name as isPasswordsEquals and set Type value to boolean. Close dialog
box.

4. Click on operation name on the message and press Spacebar to edit text field. Edit message
name to match equals = isPasswordEquals().

ii. Create alternative fragment.

1. Click the Alternatives button [t Aternatives  an4 draw alternatives fragmetn from LoginDialog
to InstructorProfile.

2. Click on empty brackets and type in equals = = true.

interaction Charge Password | B Change Password | |

x o) ()

1 hi‘trl.;:hr : LoginDialog : SystemAccessManager : ProfileManager : InstructorProfile
| |

I1: Type in nesw password beice

T egualz= EPazswordEguals()

|
|
|
|
|
|
at | | [ |
|
|
|
|
|
|

[equals F=trus]

[elze]

———— == = = =

|
|
|
|
|
T T T T
|
|
|
|

Figure 5 -- The Change Password sequence diagram

iv. Create changePassword() call message from LoginDialog to SystemAccessManager.

1. Click the Call Message L), CallMessage  button and draw message from LoginDialog to Sys-
temAccessManager.

2. Create new operation changePassword() with type boolean.



v. Create the rest of the messages:

1. Repeat the first step to create changePassword() call message from SystemAccessManager to
ProfileManager and setPassword() call message from ProfileManager to InstructorProfile.

2. Create reply messages to return changed variable to LoginDialog.
3. Create showPasswordChangeMessage and showErrorMessage

| interaction Change Pazsword | E Change Paszword IJ

X 9

: Instructor : LoginDialog : SystemAccessManager : ProfileMapaner : InstructorProfile

11 Type in new mswurdhﬁlﬂ:'

2 egualz= izPazswordBoeals()

|

o

e et

T
|
|

Figure 6 -- The Change Password sequence diagram
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JAVA REVERSE TO
SEQUENCE DIAGRAM

NOTE: This functionality is available in Enterprise edition only.

A particular java source code file will be used to show how java reverse to sequence diagram is performed -
extracted src.zip file from java home directory.

STEP #1 Create code engineering set

1. Create a new project in MagicDraw.
2. In the Browser tree, from the Code Engineering Sets shortcut menu, choose New. Type the
name of the java set in Browser.

3. From the newly created set shortcut menu, choose Edit. The Round Trip Set dialog box
appears. .

ERuund Trip Set

Warking Direckory IE:'\temp'&nrg'\apache

1.

Wiarking Package: IData

Addd Files | Add D ata from Model |

All files: Set:
I:5) CMempharghapache = ¥ 2va_Set [Java)

B CTimz0n - =SLTProceszordpplet. java
E-5) xalan
-5 clent

7]-|7) extenzions
B0 lb addal |
E-7) processor
B res Add Recursively |
E-I5) serialize
E-5) templates REMLVE |
E-) trace o
-5 transfomer Remnave Al |

- et -
P ol N rcioue imaas
il ) | LlJ

Files of type:
I.Java zource files [7.java) j

(04 | Cancel | Help |

4. In the Add Files tree, select java file and add it to the Set list. Click OK. Class source files is
added to the java set in Browser.
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5. From the java source file shortcut menu, choose Reverse, define reverse options and click OK.
A new model with packages and classes will be created in the project.

_/% Cantai, . rﬂﬁh Inherit, . rf::_‘:' Diagrarns re::b Model E..

Containment o R X

o (e |8 | B - =

-] Data

E@ Code engineering sets

B £ Jave_Set (lava)
b
Propetties Enter
F.enarne F2
i Delete Delete

Edit Source
Generate
Check Syntax
Refresh
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STEP #2 Create sequence diagram from java source

1. In the Code Engineering Sets tree, expand the java file structure and from the class method
shortcut menu, choose the Reverse Implementation command.

El %L TProcessorapplet, java
BB #5LTProcessorapplet

B
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m_calThread
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m_stylelJRL
m_stylelJRLOfCached
m_kFactory
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PARAM_documentURL
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getResultTreefsText)
gebSource])
getSourceTreedsTexk()
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getTreedsTextiString treelURL)
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.....
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2. The Sequence Diagram from Java Source Wizard appears.

Eﬁequence Diagram from Jaya Source Wizard ﬁl

Type Sequence Diagram name:
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i~ 2. Select Operation
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E ML Profile For Java <<modellibrary == < <auxilaryResow
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e The same wizard can be opened from the Diagrams main menu by choosing Diagram
Wizards command, from the Tools main menu, choosing Model Visualizer, or from the
method shortcut menu in the Browser, choosing the Reverse Implementation command.

3. In the Step 1, specify the name of the sequence diagram and select the package, where this
diagram will be created. By default, name of the class and method will be given to the sequence
diagram. For example: Class.Method implementation. Click Next.

4. In the Step 2, select method (operation), which will be displayed in the sequence diagram.
Specify the Java source file, if this file cannot be found automatically. Click Next.

Eﬁequence Diagram from Jaya Source Wizard ' i El

Select operation:

= 1, Specify name and package

B--£7 xalan ;I
{* 2. Select Operation B~ client

i~ 3. select classes for diagram Eg LU EEa A alEt
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Select operation, which implementation (| 000 @ +getParameterInfol)  java:lang: :String"[]11" -

you want ko visualize, IF source file canmok (| B @ Hnit() ¢ void
be found automatically, wou must select || b & +skart() : woid
Jawa source file manualy. |} i £ +paintf g : javarawt:Graphics ) void

------ O +skopl) ¢ wvaid

------ 0 +sebSkyleURL] urlSkring @ javalang:s Skring e
------ 0 +setDocumentURLE urlSkring @ java::lana: Sthin =
B i b
Select Java source File:
IC:'l,temp'l,-:urg'l,apau:he'l,xaIan'l,cIient‘l,KSLTPru:ucessu:ur.ﬁ.pplet.jave i I

< Back Next = Fimish Cancel | Help |




5. In the Step 3, select other referenced classes, which you want to be displayed in the diagram.

Eﬁequence Diagram from Java Source Wizard ﬂ
Classes:
i~ 1. Specify name and package
Bl [¥ & Data
(" 2. Select Operation B [F B java
{* 3, select classes for diagram El ¥ 3 lang [iaval
i~ 4, Specify symbols properties “ [ & Thread [java::lang]

Displays all referenced classes. Select the
desired classes to show on the diagram.

(press SHIFT and click bo select recursively) i |

[~ &nalyze and split long expressions in diagram
[~ Create reply messages
[T ‘Wrap messages bexk

[aximunm wWrapped messages name [ength Gin pixels ISI:II:I

< Back Mext = Finish | Zancel | Help |

Click Next.
Select the Analyze and split long expressions in diagram check box if expression contains
calls and cannot be displayed as call message. Then every call will be shown as separate call
message with temporary variable initialization.

Select the Create reply message check box, if you want to display reply message for every call
message.

Select the Wrap messages text check box and specify the maximum message text length in
pixels, to wrap longer message.
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6. In the Step 4, specify the presentation style for elements in created diagram.

Eﬁequence Diagram from Java Source Wizard

i~ 1. Specify name and package

Specify symbal properties For diagram elements:

{~ 2. Select Operation - Sequence Mage BB = =2 B
H General -
i~ 3. select classes For diagram Fill Calar REE . I
{* 4, Specify symbols properties Use Fill Colar ¥ true
Pen Color MRGE ...
Specify properties For symbals of model Text Colar HMRGE ...
elements, Font Arial 11
Autosize [ false
lUse Fixed Can... [ False
Header inBold [ true
Stereotype Color Il RGE ..
Stereotype Font Arial 11 -
{MName)
(Descripkion)
il | _pl Resel bo Defaults |
< Back | [ e | Finish | Cancel Help |
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7. Click Finish. The sequence diagram is created.

- [Hi %51 TProcessorApplet.destroy implement ation |
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she Text Box - : -
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B3 Image Shape | object | | this : XSLTProcessorApplet | | m_trustedworker : Thread
e 1,1| T . T
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el Leop
Fd Option || - o Ccobaaeeaste o o L e I.
fZ] Interaction Use 3. M rustediorker Siopl) - I
= Callmessage LY [CTUETUNEIN T IRR
=+ Send Message i, m_trustediAorker = null I
=== REphr Message |
38 Create Message I
=+ Destroy Message I
", Diagonal Message | |
=1 Message to sef ol [ s sseuroncatien < o
Grrenmemessoee || (M [
] Duration Const... » |
e 6 m_documenlURLOMCached = nul |
|
|
L] |
L |

STEP #3 Extend sequence diagram by method

1. In the diagram pane, select method (message), which you want to be displayed more detail
including referenced classes and other defining methods.
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2. From the message shortcut menu, choose Reverse Implementation command.

= Message to sef

[F Recursive Message

ol Duration Const,..
-

| object

ih-zHems Biorz)a-daB] K Qo)

this 1 ®SLTProcessorfpplet m_trustedhdorkar : Thread

interaction XSLTProcessorAzpiet destroy implementation] Il XSLTProcessorAppiet destroy imslementation J

|m_|rmmw Trm-d[

1 1! desiren)

2 [ruib=m_frustediorker]

B

o [EIEl N

=1

1

-

=
1

Srymibaol(s) Properties. ..

Ga Ta

Seledt in Conkainment Tree

Related Elemants

AlL+E

“Shereabypa

Raeset Labels Positions

Show Stereokypas
Shaw Tagged Yalues

Create New Operation

Unknown Message
Call Message
Creaba Messaga
Reply Message
Dastroy Message
Send Message
Asyncheonous

-

3. The Sequence Diagram from Java Source Wizard appears. Following instruction in Step 2,
define wizard options and click Finish. Additional new elements, which define the selected
method, are added to the sequence diagram.
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APPLYING DIFFERENT
COLORS

Diagrams may have a set of different types of elements. For example, in the class diagram you may draw pack-
ages and classes. All those elements can be colored in the same color that you chose for your views. To make
diagrams more clear, you may color elements of different types with their own color.

An example of two implementation diagrams, created in one project, will be used in this tutorial.

Implementation diagram, called Workstations:

==component== @
LINIX
Transaction
——— ddcumpnn?ntbbg
Program Tragﬁammm
. ie
| Library
==glppors==
W =<tomponent==1 ]
o5 - Client
Silicon Graphics Program
o2

This example was taken from "UML Toalkit'" by Hans_Erik Erikssan and Magnus Penker



Implementation diagram, called Java Files:

ﬁdcumpunentbbg
home.html

I
I
H

==component== E
ammlogo.java

é____

I
H

==component== E
animlogo.doc

n

=components= E
animator.java

= — — — -

==camponents= E
animator.doc

This example shows a typical dependency among few components:
html file with embedded Java applet and software documentation files.

STEP #1 Select all analogous shapes

1. In the Workstations diagram, press and keep holding the ALT key.

2. On the Diagram pane, click the component instance Client Program element symbol. All analo-
gous shapes are selected.

STEP #2 Open the Properties dialog box

1. When you have components selected, right-click the diagram and from the shape shortcut
menu, choose Symbol(s) Properties.
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2. The Properties dialog box appears:

Pl

B = moeg
E General -

Fill Calar RiaE [255, 255, 204]

Ise Fill Calar [ true

Pen Calor M RGE [66, 66, 66]

Text Colar W RGE [0, 0, 0]

Fank Sansserif 11

Autosize [ False

IUse Fixed Connection Points [~ False

Header in Bold ¥ true

Sterentype Color WRGE [0, 0, 0]

Stereokype Font SansSerif 11

Show Stereotypes [+ true

Show Constrainks ¥ true

Show Crwner [ False

Show Tagged Yalues [ true

Conskraint Text Mode Expression

Show Full Classifier Type [ False lll
(Mame)
¢ Descripkion)

apply Skyle: IDeFauIt
[T Make Default

2

Cancel |

Help |
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STEP #3 Open the color dialog box

1. In the Properties dialog box, the Fill Color field, click the '...” button. The Color dialog box
appears:

Recent:
o |
1
|

Presiew
-

D Sample Text Sample Text

CK, I Cancel | Reset |

2. Choose the color you wish to be assigned to the element. Click OK.
3. In the Properties dialog box, click OK. The colors of the selected shapes will be changed.

ddcumpunentbbg
LIHIX
Transaction
i ﬂdcnmpnn?nt:bg
Program Transaction
: Client
| Librany
==gupports==
L ddcnmpnnentbbg
T - Client
o2
NOTE If you want to make the selected color as default for the newly created

shapes, in the Properties dialog box select the Make Default check
box.



STEP #4 Change properties using Project Options dialog box

1. From the Options main menu, choose Project. The Project Options dialog box appears.

EPruject Options : EI
...... E g!eneral Tru:fuiect options Symhol
------ == Diagram lnfo Bz A ;
=00 Symbols properties styles i B E i
(=Rl el (Default) clihenetal
B Shapes Fill Color RGE [255, 255, 204]
[ Paths Use Fill Color [ true
% Diagram Pen Color W RGE [66, 66, 66]
-« Stereotypes Text Calar W RGE [0, 0, 0]
Bl Code Engineering Font SansSerif 12
------ 4 Code Generation
------ 7 Reverse
------ 1 Java Language Optiong
...... ] C++ Language Dptions
------ 1 Cit Language Options
------ 1 CORBA IDL 3.0 language of
------ 1 DDL Language Options
{Mame}
(Descripkion)
ll | _bl apply | Resek bo Defaulks |

Ik | Zancel | Help |

2. In the General Project Options tree, expand the Shapes section and select the Component
element.

STEP #5 Extend properties by implementation diagram

1. From the Component shortcut menu, choose Implementation diagram. Style properties that
may be applied to component element only in implementation diagram, appears.

31 Copyright © 1998-2011 No Magic, Inc.



2. Change the Fill Color and Pen Color properties values, by clicking the '...” button. The Color
dialog box appears. Submit changes.

EPruject Options

-2 Shapes
------ Accept Event Action
------ 1 Action

------ i Achivity Edge Connectar
----- 0 Activity Parameter Hode
- R Achor

- Artifact

------ 1 Call Behawior Action

------- Call Operation Action

------ [ Central Buffer Mode

- Clazs

422 Collabaration

----- <i Collaborationl ze

------ 1 Combined Fragrment

E--#] Component

Composite Structure Diag
E Implementation Diagram

------ E Content Shape
------ . Data Stare
...... @ Data T_I,IDE
------ <x Decigion Mode

------ Ciagram Info
....... B Miacram Shans

ol

Component / Implementation Diagram
Hel 2Bl =E
Property Hame Property Y alue Inherited
= |
Fill Color RGE [255, 204, 204] |
Ise Fill Calar ¥ true W
Pen Color M RiE [255, 51, 51] |
Texk Colar W RGE [0, 0, 0] ™ i
Fonkt Sansserif 12 ¥
Autosize [ False W
IUse Fized Connectio.., [ False ™
Header in Bald [+ true ™
Stereotype Color W RGE [0, 0, 0] ¥
Skereokvpe Font SansSerif 12 W
Show Stereotypes ¥ true ™
Showe Constrainks [+ true ™
Show Chwner [~ False ¥ &
General
apply | Remove | Reset ko Defaulks |

CIE |

Cancel |

Help |

3. In the Project Options dialog box click the Apply button. The Select Diagrams dialog box

appears.
[Xselect Diagrams i X|
General |
Mame Owarier
Alg| Workstations

i

Select Al |

nselect Al |

(8].4

| Zancel |

Help |

NOTE!

Only Implementation diagrams are displayed in this list, because prop-

erties were extended by this type of diagram only.
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4. Select the Java Files diagram and click OK. The Select Properties to Apply dialog box
appears. By default, all properties are added to the Selected list.

Eﬁelect Properties to Apply ﬂ
Froperties I
all: Selected:
Fill Calar -
I1z& Fill Calor
Pen Calor
Teut Colar
Faont
ALtozize

= |1z& Fixed Connection Paints

Header in Baold

= Sterentype Color -
K B
(4 | Cancel Help |

NOTE! To apply not all properties, use the ‘< ‘ button and move irrelevant
properties to the All list. Only selected properties existing in the
Selected list will be applied.

i1 L L L

5. To submit changes and close dialog boxes, click OK. Changes were made to component ele-
ments but only in Java Files implementation diagram.

ddcnmpnnentbbg
home.html
[
|
b
ddcnmpnnentbbg ddcnmpnnentbbg
animlogo.java = — — — - animlogo.doc
|
h
ddcnmpnnentbbg ddcnmpnnentbbg
ammator.java e — — — 4 animator.doc

This example shows a typical dependency among few campanents:
htrml file with embedded Java applet and software documentation files.

NOTE! Component element color in Workstations diagram remains the same
without any changes because only Java Files diagram was selected in
the Select Diagrams dialog box to apply changed colors.



APPLYING IMAGES TO
STEREOTYPES

STEP#1 Organize Stereotypes in the Browser, Model Extensions
Tree

1. In the Browser, Model Extensions Tree tab, there are all project stereotypes listed. Use but-
tons to group them by profile or metaclass. :

'ﬂg Contair.. rﬁgﬁ Inherita. . rf::_{' Diagraryi:b Model Ex..l

Maodel Extensions o R o

Bl

-] DEL Customizakion =
E MagicCraw Profile
E|E| 1ML Skandard Profile
: -7 Abskraction
-] ArtiFack
-] BehavioralFeature
-7 Class
H-% auxiliary [Class]
~#% jmplementationClass [Class)
- control [Class]
~% focus [Class)
it kliky [Class]
- boundary [Class]
- entity [Class]
% bype [Class)
-] Classifier
-] Component
-] Dependency
- Model o
-] Package
—

m...H...H...H

].H.H.H.H.E
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2. You may choose an existing stereotype from the tree or add a new one from the metaclass
shortcut menu, by choosing New and then Stereotype. The Select Package dialog box opens:

ESE'EEI: Package x|
General I

==

- UML Standard Profile <<auxiliar

Kl | L

e

Ik | Cancel | Help |

3. Select package, where newly created stereotype will be saved and click OK. Type the name of
the stereotype in the Browser.

4. Press Enter, double-click or from the stereotype shortcut menu, choose Specification. The
Stereotype Specification dialog box opens.

STEP#3 Choose an icon for the stereotype

1. Click the “...” button near the Icon field. The Open dialog box appears.
2. Select the image to be attached to the stereotype, and click Open. An icon appears in the Icon

field:
Eﬁterentype - hardware actor 3_ 5[
B B — = = Hiskory: :I u hardware actar [Class]ﬂ

L3 ;A dweare ackor [Class] ~hardware ackar
& DacumentationHyperlinks = ; ; ;
E Tag Definitions oE| % E'-i B2 I:'r':":'ErtiES:IS':E“-":I'EW':I 3 M
Sterectyped Elements
Relations
Tags

Cwner Data
Lo Constraints e

El stereotype
Mame hardware ackar

Is &bstract [ false
Metaclass E Class [UML Standard Prafile: |

To Do

Back | Eoriard | Help |

NOTE: GIF, JPG, JPEG, SVG, PNG, and MDICO files are attachable.
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3. In two opened dialog boxes click Close and OK.

STEP#4 Applied Stereotype Property

1. Right-click the class shape and from the shortcut menu, choose Specification. The Class
Specification dialog box opens.

2. Choose the Applied Stereotype property and click the “...” button to apply a newly created
stereotype from the list. Click Apply. Click Close. The icon is added on the class element sym-
bol

'F,g- & = Hstory {2 ~]

Lo
B4 DocumentationjHyperlinks ; :
% Attributes =38 B 5% Prq:lartias:lﬂbandard vI * l:l.EtCImIZB%

- Ports B Class
—5 Cperations Naine

E' Behaviars o B Data

Y] Template Parameters I ———

~I3 Inner Elements PRieC = L

-0 Relations Base Cj

— Tags Realize [T =* autoGenerstedMame [MamadElement] [LIML Standard Profile: ;MagicDr
E Constraints ) Visibili: [ =» auxliary [Class] [UML Standard Profile: LML Standard Profile]

-] Language Properties Is Aty

Is Abst [T ™ boundary [Class] [UML Standard Prafile: :UML Standard Profile]
To Do T control [iTlass] [UML Standard Profile::UML Standard Profile]
M 24, Customization [Class] [UML Standard Profile: MagicDraw Profile::DSL
[T @ enbity [Class] [UML Standard Profile::UML Standard Profile]
[T =* Focus [Class] [UML Standard Profile: sUML Standard Prafie]
—|[F ["_] hiardweare ackor [Class)
Close | Harh | [T «* HyperlinkOwner [Element] [UML Standard Profile: :MagicDraw Profile]
[T «* implementationClass [ Class] [IML Standard Profile: :UML Standard Pro
> 0 [T «* InvisibleStereotype [Element] [UML Sxandard Profile: :MagicDrawe Profi
f ' r

% regization [Classiber] LML Standard Profile: :UML Standard Prohle |

ppply | clearal | mew | cancel |

STEP#5 Suppress attributes and operations

1. Select a class and from its shortcut menu, choose Presentation Options.

2. Select the Suppress Attributes check box.

3. Go again to the Presentation Options menu and select the Suppress Operations check box.
4. A new notation for your element appears on a diagram:

==hardware actor==

TIP You can suppress attributes and operations using a smart manipula-
tion feature. Select a class and click on the buttons with ‘minus’ sign.
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==hardware actor== u
Clazs

&
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DATA PARTITIONING

NOTE This functionality is available in Standard, Professional, Architect, and Enterprise editions only.

For starting work with a data partitioning, from the MagicDraw installation directory, samples folder, case stud-
ies subfolder, open the Inventory Control System.xml.zip project.

STEP #1 Export a new Module

1. In the Browser Tree, from the Data package shortcut menu, choose New Element and then
Package. Name this package directly in the Browser as Inventory Control System.

rﬂg Contai.. r,_rﬁh Inherit.. rf::f:' Diagrams r::::- Maodel E..

Zantainmmenkt s
oo | E BB

El-&] Data

E Implementation View

Il entory Control Syskem

+-{7] Tkeraction Yiew

-7 Obiject Yiew

-7 Package Yiew

-7 Skatic Yiew

E-7 Use Case Yiew

E Prafile_For_Irwventory Control System

-3 Product

7473 Recsive Product

P Index

------ @ Code engineering sets

2. Select the Static View package and drag it to the newly created package. A class diagram with
all contained elements now is an inner element of the Inventory Control System package.

3. From the Inventory Control System package shortcut menu, choose Modules, and then
choose Export Module. The Export Module dialog box appears.



[MExport Module x|

All data: Selected packages:

B Data £ Inventory Control Syskem
£ Implementation Yiew

i lnentory Control Syskem

£ Iteraction Yiew

£ Chject Yiew e |

-3 Package Yiew

m ML Standard Profile <-<auxilia

-7 Use Case View

------ . Profile_for_Inventory Control 2
4 | i

Profile Module Description

add |

Femoyve Al |

Ok, | Cancel | Help |

4. The Selected packages list shows, which package will be exported as a module. Click OK.

NOTE If you want to check for dependencies and module you are exporting
depends on external project elements, the Package Dependencies
dialog box appears. Using this dialog box, solve errors. Then you will
be able to export module.

5. The Save dialog box appears. Select the destination directory, where you want to save the proj-
ect module, type the file name Static View and click Save. The name of the module appears in
the Browser, near the package name.

-z

i @£ Implementation Yiew
m Inventory Control System [Skatic View, mdzip]
- Tteraction Yiew

NOTE The exported module is not editable after exportation. If you want to
make some changes, from the module shortcut menu, choose Mod-
ules, and then choose Import Module. The module will be merged
with a project model.

STEP #2 Open module as a new project

1. In the Browser Tree, from the Inventory Control System package shortcut menu, choose Mod-
ules, and then choose Open Module As Project. A new project is opened.

2. In the Inventory Control System package, the Static View subpackage, select the Top Level
class diagram and open it from the diagrams shortcut menu choosing Open. The Diagram pane
with element symbols appears.

3. Add two attributes to the class Customer. Select this class in the Diagram pane. From the class
shortcut menu, select the Presentation Options command and clear the Suppress Attributes



check box. In the Diagram pane, press CTRL+ALT+A. A new attribute is added to the class.
Type the name for the attribute Name. Add one more attribute, name it Address.

& places
Canstoarser | - [ i 1 g Linslinen

“Mame X

whidress | —_—
serialy |
%l

el g ]
Shiprmient ) Product ne 1 Productl o ation
i Li]

Wensbor Shipmenl | CustomerShigamen CustomProduct . r Wensdos Product

4. Save the changes, made to this project.

STEP #3 Reload the module

1. From the File main menu, choose Opened Projects, and then choose Inventory Control Sys-
tem.mdzip. The previous project will be opened.

2. In the Browser, select the Inventory Control System module. From its shortcut menu, choose
Modules, and then choose Reload Module.

3. To see changes were applied to the module, open the Top Level class diagram. The class Cus-
tomer has two attributes.



PERFORMING ROUND

TRIP

NOTE Code Engineering is available in Professional, Architect and Enterprise editions only.

Three classes, presenting the system for controlling the luggage storage in an aircraft will be used in this tuto-

rial:

e Luggage — represents a piece of luggage;

e LuggageCompartment — represents the luggage compartment of an aircraft during a flight;

e FlightSegment — represents a flight segment.

Luggage

-wveight ¢ flost
==getter==#getWeight() : float

LuggageCompartment

-mhaeight © float
-pieces ; Wectar
-wyeight ¢ float = 0.0F

#checkluggager piece | Luggage 7 void
==constructor==#LuggageCompattment] maxdveight ; float )

FlightSegment

#Fluggage ;| LuggageCompartment

#checkluggage( piece . Luggage 1 waoid

STEP#1 Add elements to the newly created code engineering set

1. In the Browser tree, from the Code engineering sets shortcut menu, choose New, and then
Java. Type the name of a new set in Browser. A new java set is created.

2. From this newly created set shortcut menu, choose Edit. The Round Trip Set dialog box

appears.

41
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3. Open the Add Data from Model tab and from the All Data list to the Set list, add the selected

classes.

ERuund Trip Set _ x|
Wiarking Direckory |<install.r|:u:|t> I
Wiarking Package: IData o I

Add Files Add Data fiom Model |
Al data: Set:
5o I ¢ (e
----- Bg UML Standard Profile{LIML_ FlightSegment.java
----- £ FlightS egment Luggage.java
3 Luggage E-[E LuggageCompartment java
% ----- ] LuggageCompartment Add |
L] Vector
addal |
&dd Recursively |
Remove |
Remove Al |
4 | i
K, | Zancel | Help |
4. Click OK.

STEP#2 Generate code

1. From the code engineering set shortcut menu, choose Generate. The Code Generation
Options dialog box appears.

2. Define options of the generation and click OK. (For more detailed information about how to
generate code, see Tutorial “Code Generation and Reverse”).

The java code is generated:

/**
* @(#) Luggage.java
*/

public class Luggage

{

private float weight;

/**
* Return the weight of this piece of luggage in kg.
*/

protected float getWeight ( )

{
}

return 0;

/ * *
* @ (#) LuggageCompartment.java
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*
/
public class LuggageCompartment
{
private float maxWeight;
private Vector pieces;
private float weight = 0.0F;
/**
* Check a piece of luggage
*
/
protected void checkLuggage ( Luggage piece )
{
}
/**
* Constructor
*/
protected LuggageCompartment ( float maxWeight )
{
}
}

/**

* @(#) FlightSegment.java
*/

public class FlightSegment

{

protected LuggageCompartment luggage;
/**
* Check a piece of luggage
*/
protected void checkLuggage ( Luggage piece )
{
}

STEP#3 Add a new LuggageException class to the model

When coding according these constraints, it is learned that exceptions need to be provided in case luggage
checking fails. To account for this, a new class called LuggageException is introduced:

1. Create a new java code file and write the source code for a new class LuggageException addi-
tion:
/* *

* An instance of this is thrown when a requested operation on luggage
* may not be performed.

*/
public class LuggageException extends Exception
/ * %
* Constructor
*/
public LuggageException (String msg) { super (msg); }
}
2. In the MagicDraw, select the created New (Java) set and from its shortcut menu, choose Edit.
The Round Trip Set dialog box appears.



3. In the Add Files tab, select the created LuggageException.java code file and add this file to the
Set files list.

ERuund Trip Set

. X
Wiorking Direckory: I::install.ru:u:ut:b |

Wiorking Package: IData

#dd Files I Add Data From Madel |
Al Files: oL

(- mEegrations ;I = g M

g b | FlightSegrent . ja
(-1 manua Luggage.java
[ﬁ mu:udelLi|.:|rariES : i LuggageCompart
g ':'::'E'T'E'F" - LuggageExceptic
+-(7) plugins
- op addal |
B[ profiles
E-[5) samples &dd Recursively |
E-5) templates |

"

lifl update HEmoe
----- I& FlightSegment. java
..... ,& Luggage. java Remove Al
----- I& LuggageCampartment. java ik
= I& LuggageE xcepkion, java ot
Files aof type:

IJava source files (* java) ;I 1 | | _hl
(4 | Zancel | Help |

4. Click OK. The code file is added to the set.

STEP#4 Create class element in the project using reverse

1. From the code engineering set shortcut menu choose Reverse. The Reverse Options dialog

appears:
Eﬂeverse Options - New El
- Create classfieldsas ———— [ Yisualization
i+ #ttributes [v “isualize reversed model
™ Associations " Launch Madel Yisualizer

: : ™ Create new Class Diagram
[+ Resalve collection generics

£+ Add bo active diagram
[T Reset already created Fields

— Analysis
~ Model refresh bype ————— Create dependencies between:
" Merge model and code [T Classifiers
% Change maodel according ko code [ Packages

(] 4 | Cancel | Help |
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2. Define options of the reverse and click OK. A new class element is added to the project and
class symbol appears on the Diagram pane.

LuggageException

==zconztructor==+LuggageException] mag ;. String )

STEP#5 Separate luggage into two types

Next, a new requirement for the software is introduced. Luggage must be separated into two types: normal and
dangerous.

1. According to these new requirements, create two new classes, DangerousLuggage and Nor-

malLuggage (subclasses of Luggage) in the model. Link them with Luggage class by General-
ization relationship.

Luggage
-wveight o flost

==getter==#geteight(] . flost

I

HormallLuggage Dangerousluggage

2. Generate the code to the Luggage class element from the set. Open the generated code file.
The additional lines are added according to the new created subclasses.
/ * %
* @(#) Luggage.java
*/
public class Luggage
{
private float weight;
/* *
* Return the weight of this piece of luggage in kg.
*/
protected float getWeight ( )

{

return 0;

public class NormalLuggage extends Luggage

{
}
public class DangerousLuggage extends Luggage
{
}



CODE GENERATION AND
REVERSE

NOTE Code Engineering is available in Professional, Architect and Enterprise editions only.

STEP #1 Create a new code engineering set

1. Right-click the Code Engineering Sets in the Browser tree. From the shortcut menu choose
New and then language.

2. Type the name for set directly in the Browser. A new java set is created..

ENgINEETifg

STEP #2 Add data you wish to generate

1. From the created code engineering set shortcut menu, choose Edit. The Message dialog box
appears. Click OK.

2. Open the Add Data from Model tab in the Round Trip Set dialog box. From the All Data list
to the Set list, add classes, interfaces, packages, or components (we have two classes already
created in the model). Click OK.

ERuund Trip Set x|
Working Direckory: |<install.r|:u:|t> I
Working Package: IData |

Add Files Add Data from Model |
All data:
E-=] Data
= addal |
Add Recursively |
Remove |
Remove All |
Rl | 1
(a4 | Cancel | Help |
TIP! To add data for generation, you can drag—and—drop elements to the

created set in the Browser tree.
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STEP #3 Generate code

1. From the code engineering set shortcut menu, choose Generate. The Code Generation
Options dialog box appears.

[Xcode Generation Options - jav: x|

Outpuk Direckary

I-::install.ru:u:ut::- ;I i |

[~ Set as woarking directary

[~ Reverse befare generation
If element deleted From model. ..
{* Delete code

" Comment code

[~ Use spaces in place of kabs

Murnber of spaces: IB

Ik | Cancel | Help |

2. Define options of the generation:
e |f the classes for which you wish to generate code were not reversed, neither the
Reverse before generation option, nor the If element deleted from model
options, will influence the generated code.

o |f classes are reversed and you click the Reverse before generation check box,
the file will be reversed once more before generation.

e |f there are any deleted elements in the model since the last reverse, the If element
deleted from model options group box determine the code generation behavior.

e To use spaces instead of tabs in the code file, click the Use spaces in place of
tabs check box.

3. After you set these options, click OK.

STEP #4 Edit generated source

1. From the code engineering set shortcut menu, choose Edit Source.

NOTE: In the Options main menu, choose Environment, select Launchers
group and click the “...” button to set a default tool for editing source
code text.

2. The generated source will be opened for editing. Edit source and save changes.



STEP #5 Reverse modified source code

1. From the modified code engineering set shortcut menu, choose Reverse. The Reverse
Options dialog appears.

EReverse Options - java_sek ] il
Create class fields as Wisualization
& ttributes [v Wisualize reversed model
™ Associations £~ Launch Madel Yisualizer

[+ Resaolve collection generics

[~ Reset already created Fields

analysis
Model refresh bype Create dependencies between:
" Merge model and code [T Classifiers
f+ Change model according bo code [™ Packages

Ik | Cancel | Help |

{~ Create new Class Diagram

+" Add ko ackive diagram

2. Define options of the reverse:
e To create attributes instead of associations, choose the Attributes option button.

3. Click OK.

Class may have a collection of other classes and use Java generics (e.g.
List<String>). If the Resolve collection generics check box is selected, types of
collection will be resolved (property type will be not collection, but real type). Select
the ceck box to reset an already created fields.

Select the Visualize reversed model check box and choose how the reversed data
will be applied. The possible choices are: create a new diagram by launching Model
Visualizer and starting Diagram Wizards, just create a new class diagram, or
place data in an active class diagram.

To merge all the differences between the elements in the model and the ones in the
file, click the Merge model and code option button. The model elements will be
updated by code. Elements that do not exist in the code will not be removed from
the model. To ensure that the elements in the model will be exactly the same as in
the source file after the reverse, click the Change model according to code option
button.

To create dependencies between classifiers and/or packages in model, select the
appropriate check boxes.

NOTE! If you have only a source code and want to create a model, from the
newly created code engineering set shortcut menu, choose Edit. Add
files you wish to reverse from your hard disk to the set, in the Round
Trip Set dialog box, the Add Files tab.

TIP! You may reverse the desired files using the Quick Reverse option:
from the Tools menu, choose Quick Reverse, select a language and
select a files you want to reverse.



NOTE

INTEGRATION WITH
CVS

Integration with CVS is available in Professional, Architect and Enterprise editions only.

STEP #1 Define main CVS options

1. From the Options main menu, choose Environment. The Environment Options dialog box

appears.

2. Choose the CVS pane.

EEn\rirnnment Options

------ [k General

------ EB HTTP Procy

..... @ kKeyboard

------ -k Plugins

------ = Resources

------ PY¥ Path variables
------ [ Launchers

...... E Experience

------ [E] External Tools
...... = EMF UMLZ (v2.
...... = EMF UMLZ (w1,

CVs

= i £ -
e = EE B

Bl General

Add project to CWS after saving
Commit project bo CYS after sawving
Update project from C¥S before lnading [ False

Location of .cvspass
Local Folder

_’I Reset ko Defaults |

Ok, | Cancel | Help |

NOTE
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3. Define options for CVS:
e If you want to add project to the CVS server every time after saving, select the Add project to
CVS after saving check box.

e If you want to commit project to the CVS server every time after saving, select the Commit
project to CVS after saving check box.

e If you want to update project when there is a new version on the server, select the Update
project from CVS before loading check box.

4. Specify the path where the passwords storing file .cvspass is located and path of local folder
where the module will be saved on checkout action.

Grouped directories, that contain subfolders with the together related
files are called modules.

5. Click OK.
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STEP #2 Check out from scratch a new module on your disk
1. From the Tools menu, choose CVS, and then choose Checkout Module. The Checkout Mod-
ule dialog box appears.

[2§ checkout Module x|
Checkout Ophions
WS rook: -peerverjolitapi@cys. nomagic. com: Aprojectz/CWS LI

Maodule name:  |productz/magicdraw
Local Falder; E-ACWS I

[~ Prune empty directaries [-P)]
[ Beset sticky tags [4]

[T Maon-recursive []

(0]'4 | Cancel | Help |

2. In the CVS Root field, enter the path of the CVS repository, which stores a complete copy of all
the files and directories that are under version control.

3. In the Module name field, enter the path where the module is stored.

4. In the Local folder field enter the path of the local folder where the module will be saved on

checkout action.
e You may select the Prune empty directories check box, if you want automatically

remove empty folders when you update a module.
e For checking out only the last project version, select the Reset sticky tags check

box.
e |If you don’t want to check out the subdirectories, select the Non-recursive check

box.
5. Click OK.

STEP #3 Add project to CVS
1. Create a new MagicDraw project.
2. Save it in already checked out directory (how to check out CVS directory, see CVS help.)
3. From the Tools menu, choose CVS, and then choose the Add Project to CVS command. The

Add Project to CVS dialog box appears.
4. NOTE: If the Add Project to CVS after Saving command in the Environment Options dialog
box, CVS pane is selected, the Add Project to CVS dialog box appears every time when the

new to CVS project is being saved.
[BJadd Project to C¥S D:Deploy_lay x|
Add Options |

[+ Add az binamy data [-kb]

Log message:

=
Ik Zancel | Help |

e If the project is saved as XML.ZIP format, select the Add as binary data [-kb] check box.




5. If needed, type the Log message.
6. Click OK.

STEP #4 Commit project to CVS after making changes

1. From the Tools menu, choose CVS, and then choose Commit Project to CVS. The Commit
Project to CVS dialog box appears.

NOTE: Project is committed to the CVS server every time after saving it, if the
option Commit Project to CVS After Saving is selected in the Envi-
ronment Options dialog box, CVS pane

Etummit Project to C¥s D:hDeploy_la ' 5[

Commit Optionz

Log message:

hat
(0] 4 | Zancel | Help |

2. In the Log message field, type the message about the project that can be important for other
users.
3. Click OK.

STEP #5 Update CVS project

1. From the Tools menu, choose CVS, and then choose Update CVS Project. The Update CVS
Project dialog box appears.

EUpdatE C¥S Projeckt D:"-.,Deplur_la:.i_ El

TG I

[+ Reset sticky tags [4)
[ Retriese rev. Aagdbranch:

| g |
Ik | Cancel | Help |

o |f the Reset sticky tags check box is selected, the last version of the project that is
on the server will be updated. If no check box is selected, you will be informed that
project is already opened but you can reload it and loose changes.

e Type the tag or version number you want to update to the Retrieve rev./tag/branch
field (it becomes enabled when the Reset sticky tags check box is cleared). You
may click the ‘..." button and in the Revision dialog box choose the desirable

version.
2. Click OK.



USING TEAMWORK
SERVER

STEP #1 login to the teamwork server

1. From the Teamwork main menu, choose Login. The Login dialog box appears.

Login |
Login: I.ﬁ.dministratur
PESSWDrd: I#############

Teamwaork server name: Iku:ulil:uris:'l 100

[ Auto login ko zerver

o | o _|

Zancel |

2. To login to the server as administrator, in the Login and Password fields, type “Administrator”.
In the Teamwork Server Name text box, enter the server name and port.

3. If you want every time when starting MagicDraw to connect
Login to Server check box.

to the server, select the Auto

4. Click OK. On the status bar the note "Logged in as: Administrator” appears. The Administrator
has administrator’s permissions (all available permissions) and is allowed to create new users.

|L|:ugged in &z Administratar
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Getting Started with Teamwork Server

STEP #2 create teamwork server users

1. From the Teamwork main menu, choose Users. The Edit Users dialog box appears.

Eeneral |

~ Users — Azzigned projects

Login Hame

I ame I

Bdminiskrator System Administr, .,

Edit model

Permizzions

Assign user bo project

Fead model
Edit project properties
Create project

Remove project

Syvskem Projeck

S I I I
HEEB@A

Edit | Add | Remove |

Lo 4 | Zancel |

Help |

2. To add a new user, click the Add button. The Edit User dialog box appears.

Pl

Edit |
Login: IB ob
Mame: IH obert Burnz

Mew password: EEEEEEE

Confirm new password: I EEEEEEE

Ik | Cancel | Help |

3. Enter the login, name, and password for the user. Click OK. A new user is created.
4. In the Edit Users dialog box, Permissions list, set specific permissions for the user by select-

ing corresponding check boxes.

5. The More>> button allows to set permissions for the users on particular projects. If there are
teamwork projects available, you can set permissions for the users on these projecits.

6. When all users are added and permissions are set, click Close.
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Editing Teamwork Projects

STEP #3 create teamwork project

1. If there are no teamwork projects created or you need a new teamwork project, from the Team-
work main menu, select Projects. The Edit Projects dialog box appears.

[XEdit Projects F x|
General |
— Projects — Azzigned uzers
EiE EFE | Login | Hame |
Mame Werzion
]

Permizziong -

Swskem Project
Assign user to project O O

Edit rnodel r F
Read model N =
Edit project properties |

O m
4] | »
Rename | &dd | Remove | Mersions |
Mare == |
(04 | Zancel | Help |

2. Select from the existing teamwork projects or add a new project using the Add button. When
adding a new project, the Project Name dialog box appears. Enter the name for a new project
or leave the default one. Click OK.

[XAdd Teamwork Project x|

Add Tearmwark Project |

Marme:! IS':.fsteml

Cancel |

3. In the Permissions list, set project permissions for the users. Click Close.

STEP #1 Login to the teamwork server

1. From the Teamwork main menu, choose Login. The Login dialog box appears.
2. Enter the user login, password, and teamwork server name. Click OK.
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Editing Teamwork Projects

STEP #2 Open teamwork project

1. From the Teamwork main menu, open a teamwork project by choosing Open Teamwork Proj-
ect. The Open Teamwork Project dialog box appears. If no projects are available, you can add
a new one by clicking the Add button. Click Open.

Eﬂpen Teamwork Project X
Qpen I

— fAvailable projects

[ system

[T showmodules [+ Show Only Assigned Rename | add | Remove | Yersions |

coce | - |

2. Look at the Browser tree. The items in the Browser tree are blank and they can be read, but no
editing is allowed. A user may add new elements and edit only those elements that he/she has

locked for editing.

STEP #3 Commit Project to Teamwork Server

1. Create a new class diagram and name it. Draw any elements and relationships in the class dia-
gram.

2. Commit the diagram to the Teamwork Server. From the Teamwork menu, choose Commit
Project (you can use CTRL+K shortcut key instead). The Commit Settings dialog box
appears. If needed, you may enter any commit comments or tags.

x|

Etummit Settings ;
Commenk | Tagsl Local Mu:uu:lulesl Locked Elementsl Locked Mu:uu:lulesl

& news class diagram is created|

Zarmmit | Cancel | Help |

NOTE! If you have some elements locked for editing, the list of them is displayed in the Locked
Elements tab. Select elements if you want to unlock them after committing project.

If your project uses some local modules, list of them is displayed in the Local Modules tab.

The Locked Modules tab displays list of modules, which are locked in this project.

3. Click Commit.
4. After committing the diagram for the first time, it becomes read-only and it is blank in the

Browser tree.



Editing Teamwork Projects

STEP #4 Lock elements for editing

1. In the Browser tree, from the class diagram shortcut menu, choose the Lock for Edit command

and then Lock for Edit.

He Contai.. rﬂﬁh Inherit.. r%ﬂ Diagrarns r-:::b Madel E.. l y i Untitled1
Conkainmmenk o R = e
[m e 3 (PP ﬁ E i Eﬂ_ .
il Bk £ Common |
E-fE Data B Naote o
E;m abe Texk Box -
- =
foe ] Code Mewy b A= Anchor o
A Depend
MNew Relation [ ey
e —
Dpen Enter Lock For Edit Recursively
Specification Lock For Edit Content
Go To 3 —& Inketface
Related Elements b B Package
Ep i ' Gereralization  *
/ Bssociakion -
Rename Fz :
g Bagregation v
5 Copy Crt+C o Composition -

2. In the Browser tree, appears a name of a user who has locked the class diagram for editing.

t 3 ClassT

3. To lock any class from a diagram for edit, from its shortcut menu, choose the Lock Class for

Edit command and then Lock for Edit.

User ~ [Terniinal
Specificatian Enter Lock For Edit Recursively
% < e N EEEEEREEE .
: New Diagram O
o To ]
. Select in Containment Tree Alt+E N o T

RElatEd Elements h ...........................

Convert To k
% : Taoals [ A e 800000

Skereokype ]

o | RERRAA AR R LA
iy Presentation Options b +++
Inserk Mew Attribute Crl+alk+a
e S R R R
: - :
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Editing Teamwork Projects

4. Perform some changes for a class. Click CTRL+K to commit changes. The diagram that was
edited once again does not become read-only, and it is left editable for the user who has locked
it.

5. In order to unlock the diagram, in the Browser tree, from the class diagram shortcut menu,
choose the Unlock command and then Unlock.

H M
Hﬁm ' Dependency
- Cod My J B Image Shape
Mew Relation ] ---- Separakor
| Unlack J Unlack L
Qpen Enter Inlock, Recursively
Specification Unlock Content
Go Ta Y Discard Changes
Related Elerments b f/ B i
Stereatype ] o Aggregation
Rename Fz / Compasikion
Bl copy Chrle A Interface Real...
NOTE! If you select the Discard Changes command, you may unlock a diagram and discard any

changes that were made by the user who has locked the diagram.
6. In the same way classes and other elements of a diagram are unlocked.

STEP #5 update teamwork project

NOTE! You have to update a teamwork project from time to time. It is necessary to receive changes
made by other users who have edited a teamwork project.

e From the Teamwork main menu, choose Update Project. All the changes made by other
users will appear in the project version that you have.



XML SCHEMA MODEL
CREATION

This guide contains step-by-step instructions, showing how to create a basic XML schema model (and then
generate the schema from this model) from scratch.

STEP #1 Create XML Schema Diagram Model

1. Create a new project.

2. In the Browser tree, from the Data package shortcut menu, choose New Diagram and then
XML Schema. Specify the name of this diagram directly in the Browser - e.g. Mail Tracking
System as in our example.

e You may also create XML Schema diagram from the Diagram toolbar menu by clicking the
XML Schema Diagram button or from the Diagrams main menu, choosing XML Schema
Diagram.

3. To create a namespace in this diagram, on the diagram elements toolbar, click the XSD-
Namespace button (or press P) and then click anywhere on the diagram pane. Type the name
(http://system/ in our example) for the namespace. This namespace will be the main container
for the types of the schema.

4. To speed up further development, in the Browser tree, drag created XML Schema diagram to
the namespace package.

'ﬂg Contai.. rﬁqﬂ Inherit, , r*&_ﬂ Ciagrams rd::b Maodel E..

Zonkainment o & =
B3| |f|B -8
El@ Data
© -0 htpifisystem|
: Mail Tracking System

: E #ML Schema Profile [XML_Schema_Profile . xmi]
L @ Code engineering sets

5. Add the http://www.w3.0rg/2001/XMLSchema namespace package to the diagram - expand
the XML Schema Profile, select this package and drag it into the diagram pane.

6. Draw the XSDSchema element in diagram and link both namespaces with ximns relationship.

7. Specify names for relationships. These names will be mapped to the namespace prefix in the
resulting .xsd file. Double-click on the relation to open the Element Import Specification dia-
log box and in the Alias field type the name, which will appear on diagram pane. You can leave
one of these relationships without name - this will be the default namespace of the schema.

8. Double click the schema element and in the opened Specification dialog, click on the Tags
tab. Expand the <<XSDSchema>> branch and select targetNamepsace tag. Click the Create



Value button. In the Select Elemets dialog, select http://system/ namespace and add it to the
list by clicking Add.

==xming== ==X SDnamespace==
i http:/isystem/
I
==k E0zchemas==
MySchema -

ftargetMamespace = hitp:fisystern/} — — —

| e |
| =X S0namespaces==

T T 7 7| httpatiwnwew.w3.org/2001/XML S chema

==xming==

9. Such a model will result (after code generation) in schema like this:

<schema targethamespace=http://system,s
xmlns="http:/Swww. w3, org 2000, MLEChema"”
amlns imy="http:/ system " /=

STEP #2 Create Model Types

1. In the elements toolbar, click on the XSDcomplexType button and draw new type on the dia-
gram pane. Name it as mailType.

2. Right-click on this type and from the shortcut menu, choose XML Schema and then New

XSDattribute.
: A
qummmplexwpew AV { o Lo o :
mailType o
. n e S
+ Symbol{s) Properties. ., Alk+Enker +++
: Mewy Diagran ¥ : : :
Lo g
+ Select in Containment Tree Alt+E +++
Related Elements ]
i p | R
- Tools b - + -
Sterectype b :
Create Roles 7 I o
Presentation Options b
: Insert Mew Attribute Chel+-Al+-a :
: il S T
#ML Schema 4 Mew XSDakbribute
] = Mew ¥S0anyattribute

3. Type the id name for new attribute. Double-click to open the Property Specification dialog box
and assign integer type in the Type field.

4. Select mailType element and from the shortcut menu, choose Stereotype. Apply <<XSDse-
quence>> stereotype for this element. This will enable inner element creation for complex type.



5. Right-click on the type again and from the shortcut menu, choose XML Schema and then New
XSDelement. Name this element as e-mail. In the same manner, add another element, named
envelope .

==X =DocomplexType==
==X SDsequences==

mailType
==X =Dattribute==-id ; integer

==d EDelement==-e-mail
==X =Delement==-envelope

6. Draw another XSDcomplexType element on the diagram and name it as mailsType.

7. When choosing types for elements, you may use either primitive typed for XML schemas from
the XML Schema Profile or your modeled types. Add new XSDelement fype to mailsType and
double-click to open the Property Specification dialog box. In the Type field assign previously
created mailType element as a type.

==X SDcomplexTypes==
==X SDzequences==

mailsType

==X S0element==-type . mailType

8. It is possible to put the name of the element on the appropriate end of the association relation.
Draw composition between mailsType and mailType, add a name and assign <<XSDelement>>
stereotype to the association end. From the end shortcut menu, choose Edit Name and then on
the diagram pane, type mail.

== ShocomplexTypes==
==X S0complexType== ) ﬁd}(SDSEEUEI’Igg‘b}
==X SDsequences= -l mailType
mailsType =
: ==X ZDelement== |22 Shattribute==-id ; integer
==}SDelement==-type : mailType ==} =Delement==-g-mai :

==X S0element==-envelope

9. After code generation, this model will result in the following source code::

<zconplexType name="tailsType™>
<ZequUence>
<element nswe="type” type="mv:imailType™/ />
<element nswe="mail™ type="mv:imailType™/ >
</ zequencer
</complexTypesr
<conplexType name="wailType™>
<ZequUence>
<glement name="e-mail"™S>
<element nswe="enwvelope™/>
</ zequencer
<attribute nsme="id" type="integer"™/ />
</complexTypesr

STEP #3 Specify Sequence Order

1. Create two more XSDcomplexType elements attachmentType and bodyType. Add appropriate
XSDelements to them - attachment and text.

2. Draw aggregation link from the mailType element to these two newly created elements.
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3. Double-click the bodyType element to open its Specification dialog box. Select the Tags tab
and in the <<XSDSequence>> branch add new tagged value “1” for sequenceOrder tag.

EEIasg = bodyType -’-(-I
E % — = = Hisbory IE bodyType [http:,l'l'g',Js:E'n,l]LI
= bodyType “Tags
E| Docurnentakiony'Hyperlinks Erofile: J{PLL} L] Property:
B Attribukes e
T Porte 1 e EIE i h; |I:E £l } Ille.‘uceﬂlrder : Erng _;I
- L
- Operations R
-] Behaviors 3 FinalDefaulk = gekE
Ternplake Parameters w3 bargetMamespace [~ HTML
-2 Inner Elements — {3 vErsion 1
-0 Relstions ]I i & anillang
= E-e» <<xSDsequences>
—@ Constrainks - b MERocurs
Language Proparties || i e {3 minCcours
- seguenceld
,,,,, o)
Bl <<XiDsimpleContent>! &
4] |

Remave value | - Edtvale| | | (L[ (2] H| =
Close Hach | Farward Help |

4. Repeat the same action for attachmentType element, just add tagged value “2”.
5. Such model after all these actions is created:

==X ShcomplexTypes=
==X SDsequences==
==X SDcomplexType== bodyType
==X S0=equences= o fsequenceCrder="1"
mailType
==K SDelement==-text

== SDattribute==-id | integer
==d SDelement==-e-mail

==XSDelemert==-envelope k== ==KSDcomplexTypes==
==X=Dzequences==

attachment Type
{sequencelrder="2"}

==ASDelement==-attachment

6. Such source will be generated from this example:

<oomplexType name="attachmentType™>
<SEqUeNnce:>
<element hawme="attachment™/ >
</ =2egquencer
</complexTypes
<ocomplexType name="hodyType™:>
<SEqUeNnce:>
<element nste="text"™ >
</ =2egquencer
</complexTypes
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STEP #4 Code Generation from Schema Model

1. Right-click the Code Engineering Sets in the Browser tree. From the shortcut menu choose
New and then XML Schema language. Type the name for set directly in the Browser. A new
XML Schema set is created.

E@ Code engineering sets
ez Syskem (XML Schema)

2. From the created code engineering set shortcut menu, choose Edit. Open the Add Data from
Model tab in the Round Trip Set dialog box. From the All Data list to the Set list, add XML
Schema elements for code generation. Click OK.

ERuund Trip Set

working Directorsy: I::install.n:u:nt:b

1.

‘iarking Package: IData

Add Files  Add Data From Model

Al daka: Sef:
EI@ Daka SRR~ stem (%ML Schema)
Yt system/ Add | - schema,xsd
¢ = MySchema
- maiType addal |
=~ mailsType
e attachmentType
¢ = bodyType
=g UML Standard Profile[LIML e |
Remove Al |

R | i
(o]4 | Cancel | Help |

3. From the code engineering set shortcut menu, choose Generate. The Code Generation
Options dialog box opens:

Etude Generation Options - Sysl:': 5'

Cakpuk Direckary

I::install.rn:n:nt:bl ;I |

[~ Set as working directary

(o | Cancel | Help |

4. Specify Output Directory for source code and click OK. The schema.xsd file containing XML
Schema code will be generated there.

62 Copyright © 1998-2011 No Magic, Inc.



	MagicDraw Basics
	Sequence Diagram Creation
	Java Reverse to Sequence Diagram
	Applying Different Colors
	Applying Images To Stereotypes
	Data Partitioning
	Performing Round Trip
	Code Generation and Reverse
	Integration with CVS
	Using Teamwork Server
	Getting Started with Teamwork Server
	Editing Teamwork Projects

	XML Schema Model Creation

